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Outlook Pocket Guide

Introduction
This Pocket Guide is a quick-reference guide to the most
recent versions of Microsoft Outlook—2000 and 2002. It is
useful for both new and experienced users of Outlook and is
put together in the following way:

• Part I provides an overview of the most important con-
cepts for working in Outlook. It should leave you with a
firm understanding of what Outlook does.

• Part II covers general tasks that apply no matter what
specific function of Outlook you are using. These tasks
are categorized by function for easy reference. While
Parts II through VIII are designed primarily as a refer-
ence, you can learn a lot about Outlook from browsing
through the tasks.

• Part III covers tasks related to setting up and using Out-
look email.

• Part IV covers Outlook’s calendar function.

• Part V covers Outlook’s contact feature.

• Part VI covers Outlook’s Task List.

• Part VII covers Outlook’s note feature.

• Part VIII covers Outlook’s journal.

• Part IX contains a number of reference tables so that you
can quickly look up otherwise hard-to-find information.

• Part X lists several online resources, additional books,
and Outlook add-in tools that may be useful to you.
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Conventions Used in This Book
The following typographical conventions are used in this
book:

Italic
Indicates new terms, URLs, filenames, file extensions,
directories, commands and options, and program names.
For example, a path in the filesystem will appear as C:\
Program Files\Microsoft Office.

Constant width
Shows the contents of files or the output from commands.

Constant width bold
In examples and tables, shows commands or other text
that should be typed literally by the user.

Constant width italic
In examples and tables, shows text that should be
replaced with user-supplied values.

Variable lists
The variable lists throughout Parts II–VIII of this book
present tasks as the answer to a “How do I...” question
(e.g., “How do I find all messages from a particular
person?”).

Menus/Navigation
Menus and their options are referred to in the text as File
➝ New, Tools ➝ Forms ➝ Choose Form, and so on.
Arrows are also used to signify a navigation path when
using window options; for example, Tools ➝ Options ➝

Preferences ➝ “Default reminder” means that you would
open the Tools menu, select the Options command,
switch to the Preferences tab, and select the “Default
reminder” option on that tab.
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Pathnames
Pathnames are used to show the location of a file or
application in Windows Explorer. Folders are separated
by a backward slash. For example, if you see something
like, “...default location is C:\Program Files\Microsoft
Office” in the text, that means the default location of the
file being discussed is in the Microsoft Office subfolder of
the Program Files folder.

Menu symbols
When looking at the menus for any application, you will
see symbols associated with keyboard shortcuts for a par-
ticular command. For example, to print an item in
Microsoft Outlook, you could go to the File menu and
select Print (File ➝ Print), or you could issue the key-
board shortcut, Ctrl-P.

TIP

Indicates a tip, suggestion, or general note.

WARNING

Indicates a warning or caution.

Used primarily in Parts II–VIII, this icon indicates that
the features discussed are available only in Outlook 2002
and newer versions. Outlook 2000 does not support fea-
tures marked with this icon.

In Parts II–VIII, we’ve highlighted some of the espe-
cially cool and useful tips for you in these boxes.
Even Outlook pros might learn a thing or two, or get
a reminder about an old favorite trick.

02+
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PART I:PART I

Understanding Outlook

The first part of this book introduces the principal functions
of Outlook. The intent of this part is to help new users hit
the ground running and to provide experienced users with a
keener understanding of why Outlook works (and some-
times doesn’t work) the way it does.

Outlook provides six primary functions, all of which interact
with one another. These functions include:

Email
Set up any number of email accounts and manage them
all from a single Inbox. Accounts can include Internet
email accounts from an ISP or mailboxes on a company
mail server, such as Microsoft Exchange Server. See Part
III for tasks specific to this function.

Calendar
Record appointments and meetings, view other people’s
calendars, and set up meetings automatically via email.
See Part IV for calendar tasks.

Contacts
Store information about people, such as addresses,
phone numbers, email addresses, and much more. See
Part V for contacts tasks.

Tasks
Keep a running to-do list complete with due dates. See
Part VI for tasks specific to this function.
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Notes
Keep free-form text notes that don’t fit anywhere else or
temporarily store information here. See Part VII for notes
tasks.

Journal
Automatically or manually record anything that happens
in your life. See Part VIII for journal tasks.

Each of these major functions gets its own part in this book.
You’ll find tasks that apply to Outlook in general listed in
Part II. Unlike Parts II–VIII, Part I (which you’re reading
now) is not really about specific tasks. Rather, it discusses
the most important concepts of Outlook—the things that all
Outlook users should understand. This part covers:

• The Outlook interface

• How Outlook stores information

• Folders and items

• Views

• Forms

• Shortcut menus

• Categories

• Address books

• Accounts

• Profiles

The Outlook Interface
Though many new elements have been added to Outlook
over the years, the basic Outlook interface has not really
changed too much. Figure 1-1 shows the Outlook interface
with all optional views enabled and all the parts labeled.
Your view of Outlook might look a little different, but proba-
bly just because you have some things (such as the Folder
List) turned off. In the following discussion of the parts of
the interface, you’ll learn how to turn each part on or off.
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NOTE

The figures in this book are based on Outlook 2002; for
the most part, you’ll find that the interface is the same in
Outlook 2000 and 2002. Any differences are indicated in
the text.

The following list describes the important elements of the
Outlook interface:

Title bar
The title bar shows the name of the folder you are cur-
rently working in. It also holds the Minimize, Maximize,
and Close buttons for the Outlook window. Clicking the
Outlook icon on the title bar reveals the control menu
with additional window commands—you can get the
same menu by right-clicking the Outlook taskbar button
in Windows.

Figure 1-1. The Outlook interface

Title bar
Menu bar
Standard

Advanced

Web
Folder

banner

Outlook
Bar

Status bar

Folder list Preview pane Display pane
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Menu bar
Menus hold all of the common commands available in
Outlook. Commands on some of the menus (especially
the Action menu) change depending on the type of folder
selected (email, contacts, tasks, etc.). The menu bar (and
other toolbars) are normally docked to the top of the
window, but you can drag them to float anywhere on
your screen (or just rearrange their docking order) using
the handle at the far left of the bar. Outlook retains the
positioning of menu and toolbars even after it is shut
down.

A feature named adaptive menus is enabled by default,
causing Outlook to show only the basic commands (as
decided by Microsoft) and the most frequently used com-
mands, unless you click an extra button to show the rest.
You can turn off this feature using Tools ➝ Customize ➝

Options ➝ Always Show Full Menus.

TIP

If you are learning Outlook, turn off adaptive menus. Be-
ing able to browse a full list of commands and find com-
mands where you expect them is vital to the learning
process. Even if you’re experienced, consider turning the
feature off and customizing your menus instead. See Part
II for more on customizing.

Standard toolbar
Toolbars work much like menu bars and, in fact, can be
customized to hold menus. The Standard toolbar holds
buttons for common commands from the File, Edit,
Tools, and Action menus. Figure 1-2 shows the com-
mands you will always see on the Standard toolbar.
Additional command buttons are added depending on
the type of folder selected.
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1. The New button (also Ctrl-N) creates a new item
based on the currently selected folder (e.g., a new
email message opens when viewing an email folder).
Click the down arrow to create a new item of another
kind (including new folders and Outlook Bar
shortcuts).

2. Print sends the currently selected item directly to the
printer with no confirmation dialog. Use File ➝ Print
or Ctrl-P to open the Print dialog for more choices.

3. Move to Folder opens a submenu that lists recently
accessed folders in Outlook. Select one from this list
to move the currently selected item there, or choose
Move to Folder to open a dialog with a full folder
list. Ctrl-Shift-V also opens this dialog.

4. Delete moves the selected item to the Deleted Items
folder. Press the Delete key for the same effect. Hold
down Shift while using the Delete button or key to
permanently delete the item.

5. Find (also Ctrl-E) opens a small Find bar directly
above the Display pane, with fields for performing a
quick search. The search defaults to the current
folder. On the Find bar, use Options ➝ Advanced
Find for more sophisticated search tools. Without
the Find bar open, use Tools ➝ Advanced Find or
Ctrl-Shift-F to open the same advanced search dialog.

6. Organize opens a new pane above the Display pane
with commands for using folders, colors, and views
to organize items and filter junk email. These tasks
are covered in Part II.

Figure 1-2. The Standard toolbar

1 2 3 4 5 6 7 8 9
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7. Address Book opens the Windows Address Book,
which is covered later in this part.

8. Type a name or part of a name in the Find a Contact
box and press Enter to open a dialog displaying all
contacts that match that name. Click the down arrow
to the right of the box to view recent searches for
contacts.

9. The Help button (also Help ➝ Microsoft Outlook
Help or F1) opens the Outlook help window.

Advanced toolbar
The Advanced toolbar is hidden by default. Turn it on
using View ➝ Toolbars ➝ Advanced. The Advanced tool-
bar holds mostly navigational and view commands from
the View menu. Figure 1-3 shows the buttons you will
always see on the Advanced toolbar. Again, other com-
mands are added when viewing certain folder types.

1. Outlook Today sends you to the Outlook Today
page, a summary view of new messages and tasks.

2. Back and Forward work like browser commands,
taking you back (or forward) to the item you were
looking at previously—even if it was in a different
folder. You can also press the Backspace key to go
back.

3. Up One Level takes you up one level in the folder list.

4. Folder List and Preview Pane toggle the display of
those panes in the Outlook window.

5. Print Preview (or File ➝ Print Preview) opens a win-
dow that shows what the current item will look like

Figure 1-3. The Advanced toolbar

1 2 3 5 6 74
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when printed. You can find more information about
printing specific items throughout this book.

6. Undo (Edit ➝ Undo or Ctrl-Z) undoes the last filing
action (such as moving or deleting an item).

7. The Current View drop-down menu displays a list of
views that you can use for the current folder. This list
changes depending on the type of folder selected.

Web toolbar
The Web toolbar contains standard browser commands
for controlling Outlook when it is used to view web
pages. Commands on this menu do not change. This
toolbar is hidden by default, but you can turn it on using
View ➝ Toolbars ➝ Web.

TIP

A quick way to customize the buttons shown on any tool-
bar is to click the small down arrow at the far right, point
to Add or Remove Buttons, and then choose the buttons
you want displayed.

Folder banner
For the most part, the Folder banner is not very useful;
unfortunately, you can’t turn it off. It shows the name of
the folder you are in (useful if you don’t keep the folder
list open or pay attention to the title bar), has back and
forward commands that duplicate the function of those
found on the Advanced toolbar, and has a few web-like
fields and buttons that duplicate the functionality of
those found on the Web toolbar. When viewing a calen-
dar, it also shows the date range. You can also click the
folder name to open the Folder List—a feature already
provided by the Folder List button on the Advanced tool-
bar and the View ➝ Folder List command.

In Outlook 2000, a similar version of this banner appears
over the Display pane and Folder List (it does not extend
over the Outlook Bar), but it does not hold the address
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box or web commands. It holds only the name of the
folder, which you can click to open the Folder List.

TIP

Right-click the Folder banner to access commands from
the File ➝ Folder submenu that manipulate the folder.
You’ll also find a command for opening a copy of the
folder in its own window—great for keeping a calendar
or contact list open while working in another folder in the
main Outlook window. This same shortcut menu is dis-
played when you right-click any folder in the Folder List.

Outlook Bar
The Outlook Bar is visible by default, but you can turn it
on or off using View ➝ Outlook Bar. The Outlook Bar is
essentially a pretty holder for shortcuts to Outlook fold-
ers, individual Outlook items, web pages, or programs
and files on your computer (or network). Left in its
default setup, it’s not nearly as useful as just leaving the
Folder List open. However, you can customize the Out-
look Bar to make it a pretty powerful tool. Check out
Part II for more.

Folder List
The Folder List is not visible by default. You can turn it
on using View ➝ Folder List. You can also click the name
of the folder in the folder banner to open the Folder List
temporarily. A small pushpin icon appears in the upper-
right corner of the list; click this to make the list stay
open. The Folder List displays all Outlook folders in a
familiar tree structure. While you can get around with
other navigational commands, and a customized Out-
look Bar can save you a lot of time, the Folder List is the
final word on navigating Outlook. It shows the actual
folder structure and every folder you have. Toggle it on
or off using View ➝ Folder List, the Folder List button on
the Advanced toolbar, or by clicking the folder name on
the Folder banner.
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TIP

Even if the Folder List is closed, you can drag an item
from the Display pane onto the folder name on the ban-
ner to pop open the Folder List. While continuing to
drag, hold the pointer over the plus sign next to any
closed folder and the folder opens in the Folder List. Drag
to the top or bottom of the list to scroll. Drop the item in
a new folder to move it there. Hold Ctrl while dragging in
order to copy, rather than move, the item.

Display pane
The Display pane shows all of the items in the selected
folder. The view and function of the Display pane
changes depending on what type of folder you view. For
information on changing views and using the Display
pane for a particular folder type, see the appropriate part
of this book (e.g., see Part III for email folders).

Preview pane
The Preview pane is hidden by default, but you can turn
it on using View ➝ Preview Pane. The Preview pane,
available for most types of folders, shows the properties
or contents of an item without having to open the item.
For example, when an email message is selected (as in
Figure 1-1), the Preview pane shows the basic email
headers (From, To, Subject, and Cc) along with the mes-
sage text.

Status bar
Outlook’s status bar really doesn’t do much. When view-
ing a folder, it shows the number of items in the folder.
When viewing an email folder, it also shows how many
unread messages are in the folder. When Outlook is
sending and receiving mail, the status and any error
alerts are shown on the righthand side.


